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Introduction to Microsoft Outlook 2007 
 
The following module has been designed to offer the user a general introductory 
overview of Microsoft Outlook 2007. The primary focus of the module is to 
familiarise the user with the Outlook 2007 environment and to provide directions 
for using the program daily in the work environment. 
 
Overview 
 
Microsoft Outlook 2007 is a comprehensive package that offers the user an 
electronic diary system whereby appointments, events and tasks can be entered 
and tracked. Detailed lists of contacts, both personal and professional, can be 
stored as well as a functional electronic mail component with a large number of 
beneficial features. 
 
With the introduction of Outlook 2007 the advanced file sharing facilities have 
become available which assist the often difficult process of working in a multi-site 
organisation where each user is able to see at a glance the availability of other 
members of staff for meetings etc.  
 
Opening Outlook 
 
There are a number of ways to open Outlook.  Two ways are: 
 

1. Double click on the Outlook icon on the desktop.  It looks like this: 
 

 
 

OR 
 

2. Click on the Start button located at the bottom of your screen, select 
Programs and click on Microsoft Outlook 
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What Outlook looks like when you open it 
 
When you first open Outlook the screen will probably look like this: 
 

 
 

Customising Outlook 
 
The window above shows the original view which will be showing when you first 
open Outlook. You can change the way the window looks to suit your own needs 
and preferences.   

 
 

The options available within the View menu are: 
 
Navigation Pane -  you have three choices with this option. They 
are,  
Normal -  this shows the folder view as in the above screen shot. 
Minimized – this shrinks the panel to a bar down the left hand 
side.  
Off – this gets rid of the panel altogether. 
 
To-Do Bar - you have three choices with this option. They are, 
Normal -  this shows the view as in the above screen shot.  
Minimized – this shrinks the panel to a bar down the right hand side.  
Off – this gets rid of the panel altogether. 
 
Reading Pane - you have three choices with this option. They are,  
Bottom-  this shows the view as in the above screen shot.  
Right – this shows the reading pane to the right of the messages.  
Off – this gets rid of the panel altogether. 
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AutoPreview - hides/un-hides AutoPreview which allows you to preview the first 
three lines of text in a message in the main message window 
 

 
 

Standard Toolbar 
 
The toolbars contain buttons that enable you to perform common tasks without 
using the menus.  The Standard Toolbar is displayed automatically when you 
open Outlook.  The Standard Toolbar displays mainly when you are within the 
Inbox. 
 
 
 
 

 
 
 
 
 
 
 
We will be looking at most of these in more detail throughout the module. 
 
 
 
Reading your Emails 
 
It is very easy to read your emails using Outlook. Your messages will appear in 
the Message Window as shown below. 
 

 
 
Your messages are usually sorted from the most recent received to the least 
recent received.  There are a number of fields that will help you to identify and 
sort your messages. 
 

 Importance tells you the priority of the message, it can be set to high or low 
 

 Icon tells you whether the email has been read or whether it is an archived 
item 
 

New 
Message 

Print 

Move to 
Folder 

Delete 

Reply and 
Forward Emails 

Categorize 

Follow Up 

Send/Receive 
Emails 

Create 
Rule 

Address 
Book 

Help 
Wizard 
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 Flag Status tells you whether an item requires your attention.  There are 
several options available for this. 
 

Reminder sorts your mail by using the reminders. 
 

 Attachment tells you whether the message contains an attachment 
 
Received tells you when the message was received by your email account 
 
From tells you who the message is from 
 
Subject tells you what the message is about 
 
Categorize you can sort your mail into categories and give it a colour to sort by 
 
 
 

 
NOTE: If you click on any of these fields, your messages will be sorted 
according to what field you clicked on (eg. if you click on attachment, 
messages will be sorted according to attachments) 
 
 
 

You can open a message by double clicking the message you want to open in 
the message pane. The message will then open and it will look like the 
screenshot below. 
 

 
 

When you have read your message you can close it by simply clicking on the 

close  button on the top of the message window or you can reply to it, 
forward it, move it etc. 
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Managing your Email 
 
Deleting Email 
 
If you wish to Delete your message you need to click once on it to highlight it 
and then either click on the Delete  button on the standard toolbar, or press 
the Delete key on the keyboard. 
 
When you delete a message it will move to the deleted items folder where you 
can retrieve it later.  To permanently delete an item from your Inbox, press the 
Shift and Delete key. 
 
Creating Folders 
 
To manage your email, it is best that you create different folders where you can 
store your emails, that way they are much easier to find than keeping them all 
within the Inbox itself.   
 
To create a new folder: 
 

1. Right click on the Inbox in the folder list 
 
2. The following shortcut menu will display 

 

 
 

3. Click on New Folder.  The Create New Folder dialog box will display 
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4. Type in a name for your folder in the Name field and click on OK 
 
5. Your folder will now appear under your inbox in alphabetical order. 

 
Moving Emails 
 
Once you have created your folders, you can now organise your emails by 
moving them out of the Inbox and into the different folders you have created.  
You can do this a number of ways, the easiest is to click on the message you 
wish to move, drag it to the folder where you want to move it to (wait until the 
folder highlights) and drop it. The message will be moved from your Inbox to the 
folder you selected. 
 
You can also use the Move to Folder button on the standard toolbar.  Just click 
on the message you wish to move.  Click on the Move to Folder  button  and 
you will have a list of some of your folders that you can move it to. 
 

 
 
 
 
 

Replying to a message 
 

You may want to send a reply to the message you received.  You can do this 
either while the message is open or from the Inbox.   
 
You have two different options you can use when replying to a message, you can 
either Reply or Reply to All. 
 

 Reply will send a message to the person who sent it to you.  
 

 Reply to All will send the message to everyone listed in the original 
email 
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To reply to the message, just click on either of these options on the toolbar.  You 
will then see a window with the email address of the original sender already in the 
To field and you will be able to type in your reply in the message body area and 
send it back to the sender by clicking on send. 
 
Forwarding a message 
 
Sometimes, you may want to send the message you received to someone else.  

To do this, click on the Forward  button on the toolbar and a message 
window will appear with a blank address bar ready for you to put in the email 
address of the person to whom you wish to send it.  The original message will be 
attached and you can either type in some extra information if you need to or just 
click on Send. 

 
Creating New Messages 
 
When you wish to compose and send a message you will need to use the New 
message  button. When you click on this button, an untitled message 
window will display. 
 

 
 
You will need to follow a few steps to successfully send a message. These are: 
 

1. Enter the email address of the person to whom you are sending the 
message in the To field 

2. Enter a subject for the message in the Subject field 
 

3. Type in the details of your message into the message area 
 

4. When you have finished composing your message, click on Send 
 
 
 
 
 

Message area 
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Selecting Recipients 
 
Instead of typing in an email address manually, you can select recipients from the 

address book.  To do this, click on the To   field and the Select Names 
dialog box will display. 
 

 
 

To find a staff member in the Global Address List you can either scroll through 
the alphabetical list or enter a few letters of the staff member’s surname in the 
Type Name or Select from List field. This will automatically scroll through the 
list to the information you have entered. 
 
When you have found the name of the person you are looking for, click once on 
the name to select it then click the To , Cc or the Bcc button to add it to that field. 
If you then double click on the name in the To, Cc or Bcc field, you can find out 
more information about that person such as their Position Title, Department, 
phone extension etc.   
 

 
 

 
To – is the person the message will be sent to 
 
Carbon Copy (Cc) – will send a copy of the message to someone else 
 
Blind Carbon Copy (Bcc) – will send a copy of the message to another person 
without the other recipients knowing that anyone else has received a copy 
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If you wish to send the message to more than one person you just need to repeat 
the process. You can add as many recipients as you wish. 
 
 
 
Contacts 
 
You can use the Select Names dialog box to also find people that you have 
listed in your Contacts address book.  To do this, select Contacts in the 
Address Book field and complete the same steps to find the names as you did 
with the Global Address List. 
 

 
 

Using the Address Book 
 

You can click on the Address Book  button on the Standard toolbar to find 
details about University Staff and your contacts without sending a message to 
them.  When you click on the Address Book button, the Address Book dialog 
box will display.  
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The Address Book works the same way as the Select Names dialog box, so to 
search for people, follow the steps listed in the section on Selecting Recipients.  
To see the Properties of the staff member, double click on their name in the 
address book. 
 
Attachments 
 
Adding Attachments 
 
To add an attachment to a message you are creating, click on the Attachment  
button in the Message tab inside the Include group. 
 

 
 

 
 

1. Click on the Attach file icon to navigate to where the file is saved 
 
2. Select the file 

 
3. Click on Insert 

 
4. The file will now be located in the Attached field of your message.  

 

Attach file or item 
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Opening an Attachment 
 
If someone has sent an attachment to you it will look something like this: 

 
 

 
 
 
 

To open the message, double click on the name of the attachment. When you 
have opened your message you have the option to save it for further use. If you 
want to save the attachment, choose Save As and navigate to where you want to 
save the file. 
 
Hyperlinks 
 
In Outlook, a hyperlink is a connection from your email message to a Web page, 
file or email address. The hyperlink itself can be text or an object such as a 
picture, graph or shape. Hyperlinks become active when you open your email 
message. 
 
To insert a hyperlink into your email message: 
 

1. Highlight the text in your message where you wish to create the hyperlink 
 
2. Click on the Insert tab and in the links group select 

Hyperlink 
 

3. The Insert Hyperlink dialog box will display 
 

Attachments 
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You have a number of options within this dialog box, let’s look at some of these. 
 
On the left hand side, you will notice a number of options under the words Link 
to:.  These will determine the type of hyperlink you create and when you click on 
these different options, you will notice some changes to the Insert Hyperlink 
dialog box as it will change some of the fields to match the option you’ve 
selected. 
 

 Existing File or Web Page: allows you to create a link to a web page. When 
you have selected this option, navigate to the file you want to link to in the Look 
in: field or type in the URL address in the Address field.  
 

 Place in this Document: allows you to create a link to a place within the 
message. When you have selected this option, select the part of the message 
you want to link it to. 
 

 Create New Document: allows you to create a link to a new document that 
you create. When you have selected this option, type the name of the new file in, 
and select either Edit the new document later or Edit the new document now 
 

 Email Address: allows you to create a link to an email address. When you 
have selected this option, type in the email address in the E-mail address field 
and type the subject of the email message in the subject field. 
 
 
 
NOTE: You can add a hyperlink to a file on the S: drive using the Existing File 
or Web page option so that staff can automatically open the document from the 
link.  Just remember that the person accessing it needs to have access to that 
part of the Shared drive. 
 
 
 
 
 
 
 
 
 

Link To 
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Signatures 
 
You can create a signature so that it will automatically appear in any message 
you send. As per the style guide include your title/ department/ phone number 
and the University’s address so that it is easy for people to contact you after they 
receive your message. 
 
To create your signature 
 

1. Click on the Tools menu and select Options.  The Options dialog box will 
then display 

 

 
 
2. Click on the Mail Format tab 

 
 
 

3. Click on the Signatures button on the bottom of the dialog box 
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4. The Create Signature dialog box will then display 
 

 
 
5. Click on New.  The New Signature dialog box will then display 
 

 
 
6. Type in a name for your signature and click on OK.  Then design your 

signature. 
 

7. If you go to the CSU Style Manual 
http://www.csu.edu.au/division/marketing/stylemanual/appli/email.html 
you will find the correct information to add to your signature.  

 
8. Click on OK and you will return to the Options dialog box.  Click on Apply 

and OK to complete your signature 
 
9. If you create a new message now, you will notice that your signature 

automatically appears in the message. 
 
 
 

http://www.csu.edu.au/division/marketing/stylemanual/appli/email.html
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Formatting text 
 
You can change the appearance of text in your message by changing its 
attributes.  This includes font, size, style, effects and colour.  
 
The Format Text tab is the easiest way to change many attributes of text.  
 
 
 
 

 
 
 
 
 
 
 
Styles - Styles allow you to quickly format a document with a consistent and 
professional look.  
 
Font Selection - Click the arrow to the right of the font name box to view the list 
of fonts available. Scroll down to the font you want and select it by clicking on the 
name once with the mouse.  
 
Font Size - Click on the white part of the font size box to enter a value for the font 
size or click the arrow to the right of the box to view a list of font sizes available. 
Select a size by clicking on it once.  
 
Bold, Italics and Underline - Formats text to be bold, italicise and underlined 
 
Text Alignment - Text can be aligned to the left, center, or right side of the page 
or it can be justified across the page.  
 
Numbered and Bulleted Lists - Adds bullets or numbers to the paragraph 
 
Increase/Decrease Indent - Change the indentation of a paragraph in relation to 
the side of the page. 
 
Outside Border - Add a border around a text selection. 
 
Highlight Colour - Use this option to change the colour behind a text selection. 
The colour shown on the button is the last colour used. To select a different 
colour, click the arrow next to the image on the button. 
 

Font Colour 
 

Text 
alignment 
 

Highlight 
Colour 
 Line Spacing 

 Bold, italics, 
underline 
 

Font Selection 
 

Font Size 
 

Outside 
Border 
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lists 
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Font Colour - This option changes the colour of the text. The colour shown on 
the button is the last colour chosen. Click the arrow next to the button image to 
select another colour. 
 
The FORMAT menu, FONT option 
1. The FONT dialog box has further formatting options including many different styles 

of underlining, superscripting and subscripting.  

2. Click that small diagonal arrow  in the lower-right corner of the Font group, the 
Dialog Box Launcher, then the Font dialog box will launch 

3. Specify the changes you wish to make, then click ok to accept the changes. 

 
 
Creating new Contacts 
 
There are a number of ways you we can create a new entry in your Contacts 
address book in Outlook.  
 

1. Click on the Contacts button in the 
navigation panel 

 
2. Then click new 
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3. The Untitled 
Contact window 
appears and you 
are able to fill in 
the fields that 
you require. 

 
 
 
 
 
 
 
 
 
 
 
 

4. When you have finished entering the details, click on Save & Close. 
 

OR 
 
You can also use the Drag and Drop option. When you receive an email from 
someone who’s contact details you would like to add to your contacts folder you 
just need to highlight their message in the Inbox, drag it to the Contacts folder in 
the Folder List and drop it.  
 
You will then see the Untitled Contact dialog box like above, but all the relevant 
information will be entered into the appropriate fields.   Just click on Save & 
Close  to finish the entry.  The message will still be available in the Inbox where 
it was originally located.  
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